—. CCSv4 &%
1. NS, BB, A autorunexe, KN R EIH . SR, s 2%,

ﬁCode Composer Studio vd.x PHEK

;fé?, Code Composer™ Studio v4
B X

# S Adobe Reader

i3 Texas BRIAEF

INSTRUMENTS SEED ELECTRUNIC TECHNOLOGY

2. fiih yes Ml &3t .

Inztall Code Composer 5tudio wd.x for China

@ This will install Code Composer Studio w4, For China on your computer, Continue?

| Yes | [ Mo

3. A NEXT $%41..

Code Compozer Studio vd4.x for China Setup &l

Welcom to installCode Composer Studio v4.x for
China

Will install Code Composer Studio vd.x For China wersion
4.1.2 on your compuker, We recoment you bo close al
other program ko inskall ik, Click "Mext" to skart inskall, Click.
"Cancel” bo abart the install,

Mext > | l Cancel




4. %Pl accept the terms of the license agreement, 5.5 Nexti% 4 .

Code Composer Studio wid.x for China Setup

Start Copying Files

Review settings before copying files

Setup has enough information to stark copying the program files. IF wou wank ta review or
change any settings, click Back. If you are satisfied with the settings, click Mext to begin copying
files.

Instal Directory:
C:\Program Files| Texas Instruments\Code Composer Studio w4.x Far China

Setup Type:
Typical

< Back ]l Next = | [ Cancel

5. FFiGest.,

HSP430 Code Generation Tools Setup

Installing
Installing MSP430 Code Generation Tools

Please wait while Setup instals MSP430 Code Generation Tools on vour computer,

Installing Windows Format Libraries...
i

L ]

Cancel

6. BadiFinishiz4.

gde Composer Studio wd.x for China Setup

Code Composer Studio v4.x For China Installation
Complete

Code Composer Studio w4.x for China has been
successfully installed Code Composer Studia v4.x For
China, Click Finish to exit the wizard,

7. B2 YES AL EH BB, Z3E5E .

System Restart reguired

6 Code Composer Studio w4, for China has been installled successfully, But you should restart your computer ko have all the components to take effect, Click "yes"
to restart immediately, Click "Mo" to restart later manually,

| ‘fes | [ Mo




. CCsv4 ‘ffﬂﬂ‘
1. $THF ccsva, Hidi OK. Ul FXJiEHE, E+E Activate a License.

e'elcune to Code Composer Studio

)

Ho walid licenze for Code Composer Studie could be found

OEvaluate Code Composer Studio for 30 days
@ik
Step 1 - Generate Licensze File

Hote: If you already hawe a license file, skip to the next step.

Fleaze note that wou will need to use one of the following Host IDs during the registration process:

cfe 6%30059 e

[ ‘ Regizter ] Regizter online using an actiwation code.

Click to activate a free license that emables you to work with XDS100 class of
[Use Fr‘ Limited License] emulatorz and emulatorsz built onto standard EVM and DSK development boards.
Thi= does not suppert using 2430 ush sticks.

Step 2 - Rnstall Licensze File
@Specif}' licenze file

OSpecif}' a Wicense server

=

| [ Browse. .. ]

=

@

2. BEER T M PR AR (RRA TR my T K-S, R, BR TR ERGED, B
AHL MAC Hihik, 41 ¢8.9¢.dc.30.05.9e. 3K 15 License Ji7, i%#¥ Specify a license file, 117 Browse,
%% TMDSCCS-ALLNO1A-v4.0.lic 3CfF. Hiidi OK, M FERE.

3. VER: HFAl SEED-XDS510PLUS. SEED-XDS560PLUS LA SEED-XDS560USB 1/ EL#% H 37 ¥
CCSvA.1.2 i A, AEFZE|4.1.2 UL ERRA, Al@ctan ™ P8RS B e A Uige, @& A
B ] 2 H B

4. HE CCS HISZH. windows -> Preferences.

B C/C+ — Code Composer Studio (Licensed)

Uile Wbt Wiew Feedgete [rejest Uemzed [edls tindow [FEaRy
.Q-_ﬁ %‘E v :,t& - 4;);' Hew Window
EICJ’CH' Frojects 2% =78
Open Perspective 3
=] F=T =F - T
= Show ¥iew 3

Customize Ferspectiwe. . .
Save Perzpectiwve Az, ..
Beset Perspective

Close Perspectiwve

Close A1l FPerspectiwves

Favigation 4




5. %% Install/Update -> Automatic Updates, HUVH2AJiET, Mio<H] B s 29 ThEe .

e Preferences |:|@®
Automatic Updates

g;g::al D;&g}_gmatically find new updates and notify me:
B[RS
Help Update Schedule
= InstallfUpdate
Automatic lUpdates

Run/Debug
Team

Terminal

=

at

Dowrload Options

< N [Restore Befaults] [ Apply ]

=)

[ 0K J [ caneel |

=\ HERRE
1. B35 b XDS560PLUS 1) EL8%J5 (XDS560PLUS 117 BL 28 A 55 B4 AR, MNIREN A

(FRERPRBRA), WHINLEIRG), HRENLEE. RS ES Eka, oK
Bk £ SEED-XDS560PIus Emulator for CCS4.0.

PO, ccsva #ra T

1. 7] LAIEFE File->New->Others, #RJ5 1%+ C/C++->CCS Project.

o New &= [ New ==
Select a wizard — Select a wizard —
Create a new C/C++/ASM project and let CCS create and manage the
makefile.
Wizards: Wizards:
type filter text type filter text
(= General B C/C++ -
B (8] CCS Project
- CVS

5 Class

¥ File

Folder

i Header File

(2> RTSC Wizards

m

RTSC Configuration Project

i[c] Source File

LI

@ < Back Next = Finish Cancel @ = Back Next = Finish Cancel

W A] DL 2% File->New->CCS Project, siih NEXT, Hi AN LFE4S, sih NEXT, iEH TR

0 ARM, C6000 %5, SER%E i NEXT, AILARINS L), 5 3%0A W B 32 st NEXT Bk
SLEET

2. 1RIEFESRIB L Device Variant, Device Endianness 25 )& 14 5, Fi7 finish 58K TAE @SR



HoAh 2 TUAT PR B BRI AR

<+ New CCS Project (23]
CCS Project Settings >

Select the CCS project settings. @
Output type: |Executable v]

Project settings

Device Variant: I<select filter= v] IGeneric C674x Device v] I More... ]
Device Endianness: Ilittle v]

Code Generation tools: [Tl v6.1.12 VI [ More... ]
Qutput Format: legacy COFF

Linker Command File: A
Runtime Support Library: <automatic= -

[ Treat as an Assembly-only project

Target content

@ None
(0) Use DSP/BIOS v5oox | 5.41.02.14 More...

() Enable RTSC support (required for BIOS v6.ax, Codec Engine v3.xx, etc.)

@ Next = [ Finish l I Cancel ]

b, —NE TR IER, T DA R SOk S

FAh, BOHTE TR S, WAE “C/C++ Projects (C/C++ TH)” ML A8 s
WH 4 FK, FFiE$E “New -> Source File GHrg -> WICAF) 7. EFTIFSTAMES, BEANES
SPEACRL AN N B Y 84 (cv .Cv .cpps .C++. .asm. .s64. .s55 Z5) ML FR.
B “Finish (GED 7

BRI H A INIAE YRS, BIAE “C/C++ Projects (C/C++ TiH )™ #EIi-R o A7 B H 5 I
HAFR, JFiEFE “Add Files to Project CESCAASMBITNE D7, WIESCAEHIBITH H %, -
WA LUIEFE “Link Files to Project CRESCAFEEREZRIINE D7 RAIE TG, IXHE AT DL SO
PREAFEHF 46 Bk




F. J& ccs3.3 TREHFASEER cesva TREXXH
1. A PR
1) %EFF File->Import, #HEXFIGHE. 1EFF Legacy CCS3.3 Project, - Hifi Next $%4H .

<« Import @

Select

A
- c et -
Imports legacy CCSv3.3 projects into workspace, migrating them to new H
format.

Select an import source:

type filter text

= General

E-E C/CH+

Bl CCS

-[% Existing CCS/CCE Eclipse Project
o« P

=, Managed Build Macras

o= CVS

E:, Team

@ = Back Next = Einish Cancel

2) % FE Project->Legacy CCS3.3 Project.
2. GEFEIUH SO ATLOE AT E SO, AT BAEIR S AZATHE . S AZAEER,
eI H P SC Bk, SRGE “Discovered legacy projects (CREIAGIHARITH ) 1% 2

SFAMLIH. F4h, & LLiEH Copy projects into workspace, K50 H#% J1 2] ccs ERNPIHT
LA,

<+ Import Legacy CCS Project IEI
Select Legacy CCS Project

Select a legacy CCS project or a directory to search for projects.

Browse...

() Select search-directory: Browse...

Discovered legacy projects:

Select All

Deselect All

() Copy projects inta workspace
@ Keep original location for each project

Create a subfolder for each Eclipse project (recommended)

2 = Back Next = Einish Cancel




3. EFEBATIH G, A NEXT, &AL B T HARA

«» Import Legacy CCS Project 3wl
Select Code Generation Tools
Select a Code Generation toal version for each migrated project.
Project 1SA Family  Tool Versi... Edit...
Litest led_dip B8 C6000  6.1.12
@ <Back | Med»> || Fnish || concel |

4. 15 EAFH ) DSP/BIOS hitA. Z AU I T 7] LALREE cCSva $2 AT ERIARA . H.f7 “Finish
GGEROD . Wit RS2 04T (RTA) FISER X R EH# (ROV) (BARNZE R EEL)
X R BIOS AR T H, w2l BRI RA .

'« Import Legacy CCS Project ==

Enable DSP/BIOS Tools
Choose DSP/BIOS support enablement for migrated projects.

DSP/BIOS support
Migration may automatically determine DSP/BIOS support enablement, for each
project, based on whether it contains a DSP/BIOS configuration file. To enable
DSP/BIOS support for all migrated projects, regardless of their content, select
the bottom-most option below.

@ Automatically determine DSP/BIOSVS.x support enablement
(©) Enable DSP/BIOSvS.x support for all migrated projects

@ | <Back || Nea> |[ Fnsh |[ cancel |

5. [AFIE O RE NG, LR cesva T H o tIAE TARIX Y .

TER: CCSvA ANSCHF csl i, W] R sl P HEATVERR S 13 BCR H LART Y sl P22 ELEGE RN 1%
ne LfL+4 - Lode Lomposer Stuadio [Licensea)
File Edit View MNavigate Project Target Tools Scripts Windo

| s~ %~ o ¥ i
0E €/C+ + Projects &2 =
-5 test_led_dip [Active - Debug]
Elg Includes
@ C:/Program Files/Texas Instruments/ccswd/tools/compiler,
i [B Ciy/Program Files/Texas Instruments/xdais_6_25_01_08/pa«
e/CCSTUD~1.3/C6000/csl/include

@ E:/360data/EELEE/project/evmomapl 138_v1/tests/ICETE
(2 E/360data/EELHE project/evmomapl138 v1/bsl/inc

B g main_led_dip.c

[]---@ test_led_dip.c

----- B linker_dsp.cmd

= ini
----- = macros.ini

----- [ test_led_dip.pijt



[ IR

AN

SABLA ccsva TR

IS ccsv3.3 LFE A4 ccsva TFE SR,

WAL

— b I %

File->Import->Existing CCS/CCE Eclipse Project, IF Legacy CCS3.3 Project. HA il #2 5 5 AHIH .

. TREXFRIE

1. e TR, 1EFE Properties, W LAHAT&FhE . 4, 7E C6000 Compiler 1L
HHi%EFE Include options &3k UM #4425 7E C6000 Compiler 1 HHi% #% Directory Specifier &
o ) SC G RS 45 7E C6000 Linker 510 HIEH¥ File Search Path A& B XA 42 o

+*+ Properties for test_ram

[RS8 Fel ===

C/C++ Build
~Info
- Builders Active configuration
~C/C++ Build Project Type: | C6000

- C/C++ Documentation

) Configuration: [Debug
~C/C++ File Types

) [Manoe-]

C/C++ Indexer

Configuration Settings
CCS Build

CCS Debug

Tool Settings | Build Settings | Build Steps | Error Parsers | Binary Parser | Environment | Macros|

Project References

(% Basic Settings:
Refactoring History X

C6000 Compiler
-~ Basic Options:
- Symbolic Debug

{5 Include Options:

(& Optimizations:

~(& Language Options:
~( Parser Preprocessing Opt &
~( Predefined Symbols:

(= Diagnostic Options:
(2 Runtime Model Options:

& Entry/Exit Hook Options:
% Feedback Options:
(2 Library Function Assumpti
(2 Assembler Options:
(5 File Type Specifier:

-~ Directory Specifier:
52 Dafault File Futen

Options:

Code Generation tools version |6.112

oo oot [ sooy

e |
-
o

2. %% Project->Build active Project iy

AT TREG 1E;

VER: %4 T Build All dr 52 488 TREAE B Iy TAEAEAT 9 3, AR IR

[ERTE

Sﬁi CfC++ - NewTargetConfiguration.ccxml| - Code Composer Studio (Licensed)

File Edit View Mavigate - Target Tools Scripts Window Help

RE®- 4

&g Rebuild Active Project

Ctrl +Shift+P
Alt+Shift+P

B c/C++ Pro... &2 Target
. . LT

[EE= test ram [Active - D

% Import Existing CCS/CCE Eclipse Project
% Import Legacy CCSv3.3 Praoject

) Build Al
& Rebuild Al

Clean Selected File(s)
Build Selected File(s)

Ctrl+B
Alt+B

Exclude File(s) from Build

Active Build Configuration

Build Project
Build Working Set
Clean...

Build Automatically

Link Files to Active Project...
Add Files to Active Project...

Properties

Ll




I\ EREEEXM, SREAERTER

1. #E#F View->Target Configurations, 7&)5i%%F Target->New Target Configuration. i A\ A,
HOTE B SO 44 FR, Bty Finish %40 (%42 0] PAFE X0,

= New Target Configuration @

Target Configuration

Create a new Target Configuration file.

[ZCXEL EIN ewTargetConfiguration.coxml|

Use shared location

Location: C:\Users\Administrator\user\CCSTargetConfigurations Browse...

@ [ Finish ] l Cancel

2. EBEAHRIHIPT EAY, PAROE . IR AT Target Configuration.

|=| macros.ini gz *MewTargetConfiguration.coxml &2 =8

Basic
[

General Setup

This section describes the general configuration about the target.
Connection SEED XDS560PLUS Emulator -

Device type filter text

OMAP3515 &
OMAP3525

OMAP3530 4
OMAP3630

OMAPL137

OMAPL138

Stellaris LM35101

Stellaris LM35102

Stellaris LM351110

Stellaris LM351133 -
m | 2

5T T

~

Spectrum Digital C5416 DSK Board -

Mote: Support for maore devices may be available from the update manager.

4 | i | 3

Basic| Advanced | Source



3. Hiili Advanced, TIAF|ILECE, ZRES A KA FRKRESSE

1|

1} J P
Basic Ad'l.ranced| Source|
% *NewTargetConfiguration.ccxml Xl =08
Target Configuration =0 [HH| =

=% OMAPL138_0
=43 ICEPICK_C
EIQ Subpath_0

----- AGf c674x0

=-TE, SEED XDS560PLUS Emulator_0

Delete

p

Down

]
dgGaad ]
i f_

Set the properties of the selected connection.
Board Data File

Emulator I/O Port
JTAG TCLK Frequency (MHz) Automatic with faster 35.0MHz limit
TMS/TDO Output Timing

auto generate

The XDS560 is at port 0x0

Rising edge allows faster TCLK

1 | 3

Basic Advanced] Source‘

4. Hi7 C674X_0, Hiifi ARMO_0, B LAVSHIM ) GEL 3CfF, 585 Hiifi Save #44H .

Target Configuration

=T, SEED XDS560PLUS Emulator_0

24 OMAPL138. 0
2% ICEPICK C

; % Subpath_0

%4 C674% 0

% Subpath_1

-AgF ARMY_0

EQ Subpath_2

Target Configuration

5
B
i

Add

Down

=T, SEED XDS360PLUS Emulator 0

-#% OMAPL138.0
2% ICEPICK_C

E| % Subpath_0

gk ceTaxo

E| % Subpath_1

™Yo 0|

EQ Subpath_2

Import..

Add

-

8|3

Set the properties of the selected cpu.
Bypass

initialization script

Browse...

Slave Processar

Set the properties of the selected cpu.
Bypass

initialization script

Slave Processor

Endianess Little Endian -
ARM Fast Download On -
Advanced Debug  On -
Arm9 Core Auto-detect -
Target Timeouts Very Fast -



5. W2E AT & S Set as Defau

|t0

C/C++ Pro.. Target Co.. =8 MNewTargetCe
B OX| Basic
tpe fter et Generalsetur
. = Projects This section d
== User Defined .
: - - Connection
o NewTargetConfiguration.cq
[# New Target Configuration )
¥ Delete
Rename
& Refresh

ﬁ Launch Selected Configuration

Set as Default

Link File to Project 4

Properties...

6. riili Debug Launch, #ENIESFH .
W+ CfC++ - NewTargetConfiguration.coxml - Co

Eile Edit

View Mavigate Project Target

e R )%

\C/C++ Pro

I Target CD---I Debug Launch F

Eile Edit View Navigate Project Target Tools Scripts Window Help

= =

JelRa % -0 - & B Borc+ (5 Debug)

Blw 5 v o o v <

45 Debug 2 | = B[ Local (1) 5 | Watch (1) B @ & |8~ = B|[B)Cheat Sheets 5 g~=g
% 0~ & - | 2 e~ [ ¥ || Name Value Address Type

Set Up Target Configuration

~ Introduction

You have opened the System Setup Editor to
create a new target configuration or to modify an
existing target configuration,

Target configuration now uses a flexible XML
schema that helps Texas Instruments and
developers define the specific details. Instead of
using the registry, Code Composer uses a
hierarchy of related XML files to define a

ion and b i inati

Since
the target configurations are XML files, they are

[

| % NewTargetConfiguration.ccxml & |

casily deleted, copied, and displayed.

Basic

This section describes the general configuration about the target.

Connection SEED XDS560PLUS Emulator

Board or Device type filter text

DAB10/DABx
DA830/DAB28
OMAP3430
OMAP3503
OMAP3515

Target configurations can be assigned to
individual projects. These projects automatically
use the assigned configurations. When you create
a new configuration, you can store them in the
User Defined folder (by default) or browse to
select the project/folder you want to assign this
configuration.

m

Target C lists the

ion options for the target.

% Do not show this again
*R Disable all cheatsheets
£7 Click to Begin

Save

<«
Basic| Advanced  Source|

o @R

& vooxs 1 w58

T — T = T —= T === =7

7. i Connect Target, 5t < iHAT
File Edit

=
- 5

View Mavigate Project Target

"!"JE:::](::]:I‘!"

HE.
Tools Wi
N e

| Disconnect Target h

Scripts

» T
8. EH )5, ¥ Load P
. B Run 125l BATRRERE .

rogram %41l (£ Connect Target #2412 J5 ), Bt vl LAIN#E SR 3 401 .out



. Eit TR

On-chip flash . : CCS->Tools-> On-chip Flash 1] on-chip flash & I, =] DLAC & B £ 2540,
SRIGTE C/C++ project T [, AifEridh T4, EHEW T4, ccs AOHHTRTRS.

File Edit View MNavigate Project Target Tools Scripts Window Help

:I‘I.—.||@ @v:ﬁ:v;@;v;’:/ﬁél}vr}vﬂj@vv ﬁ
EE m!!é New ' argetConfiguration.ccxm| &2

Go Into
L ' "
= Open in New Window _
Wl Set as Active Project rtion describes the general configuration abo
Rebuild Index tion SEED XDS560PLUS Emulatar
Active Build Configuration b lor Device type filter text
Convert To...
—
Clean Project DAB10/DABOx
Build Project DAB30/DAB28
Rebuild Project OMAP3430
OMAP3503
S OMAP3515
Past
: asl - OMAP3525
Delete
i OMAP3530
Move...
OMAP3630
Rename
OMAPL137
" Refresh OMAPL138
Close Project A o

Team | [12 Debua Local C/C++ Application




